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Safety information 
 
Do not drop or impact this product as it may damage the product or cause injuries to the user. 
Use this product in an area with good ventilation. The product may overheat and cause a fire. 
Use the correct plug and do not use a damaged cable for this product. 
Do not touch the plug or cable with wet hands to avoid the electric shock. 
Use the proper AC power to avoid fire and electric shock. 
Keep away from fire and heat. Excessive heat may alter the shape of the product. 
 
DANGER 
Electric current from power, telephone, and communication cables is hazardous. To avoid shock 
hazard, do not disassemble this product or attached devices. If a 3-pin power cord is provided with 
this product, it must be used with a properly grounded outlet. 
 
Reduce the risk of fire and electric shock by always following basic safety precautions, including 
the following: 
- Do not use your product in or near water. 
- During electrical storms: 
 
WARNING 
If the rechargeable battery pack is incorrectly replaced, there is danger of an explosion. The battery 
pack contains a small amount of harmful substances. To avoid possible injury: 
- Replace only with a battery of the type recommended by HTN 
- Keep the battery pack away from fire and heat. 
- Do not expose it to water or rain. 
- Do not attempt to disassemble it. 
- Do not short-circuit it. 
- Keep it away from children. 
 
CAUTION: 
Do not put the battery pack in trash that is disposed of in landfills. When disposing of the battery, 
comply with local ordinances or regulations and your company's safety procedures. 
 
The fluorescent lamp in the liquid crystal display (LCD) contains mercury. Do not put it in trash 
that is disposed of in landfills. 
Dispose it as required by local ordinances or regulations. 
The LCD is made of glass. Rough handling or dropping the computer can cause the LCD to break. 
If the LCD breaks and the internal fluid gets into your eyes or on your hands, immediately wash the 
affected areas with water for at least 15 minutes; if any adverse symptoms after washing, get 
medical care. 
 
To reduce the risk of fire, use only the adaptor included in the package 
 
Store packing materials safely out of the reach of children to prevent the risk of suffocation from 
plastic bags. 
 
The information in this document is subject to change without notice. 
HNT COMPANY SHALL NOT BE LIABLE FOR TECHNICAL 
OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE 
FURNISHING, PERFORMANCE, OR USE OF THIS MATERIAL. 
Microsoft, MS, Windows, WindowsNT, and the Windows logo are trademarks of Microsoft 
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Corporation. Intel is a trademark of Intel Corporation. All other product names mentioned herein 
may be trademarks of their respective companies. The company shall not be liable for technical or 
editorial errors or omissions contained herein. The information in this document is provided “as is” 
without warranty of any kind and is subject to change without notice. Nothing herein should be 
construed as constituting an additional warranty. 

 

FCC STATEMENT 
 

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. 
 
This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. 
 
If this equipment does cause harmful interference to radio or television reception which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures. 
 
- Reorient or relocate the receiving antenna. 
- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 
- Consult the dealer or an experienced radio, TV technical for help. 
- Only shielded interface cable should be used. 
 
Finally, any changes or modifications to the equipment by the user not expressly approved 
by the grantee or manufacturer could void the users authority to operate such equipment. 



 

 

Routine Care 
 
To keep your Device in good condition and working properly, follow these guidelines: 
 
• Your Device is equipped with a highly sensitive LCD touch-screen display; and should be used at 
a normal room temperature. If your Device was exposed to cold temperature for an extended period 
of time, place the device at room temperature for at least ten minutes before use. 
• Keep your Device away from excessive moisture and extreme temperatures. Do not expose your 
Device to liquids or precipitation. 
• Do not carry your Device in your pants pocket or at the bottom of your bag where excessive 
pressure may damage the touch-screen. 
• Do not place anything on top of your Device to prevent damage to the screen. 
• Store your Device in a protective case when not in use. 
• Clean your Device by wiping the screen and the exterior with a soft dry cloth. Do not use abrasive 
or volatile cleaning product, or a wet cloth for cleaning your Device.  
• Avoid exposing your Device to direct sunlight or strong ultraviolet light for extended 
periods of time. Also avoid scratching the surface of the screen and banging it against 
hard objects. 
• Only use the Device stylus pen to prevent scratching the screen. 
• The lithium battery in your Exilien may discharge if the device is not used for an extended period 
of time. The battery discharge may cause the loss of your data; therefore, we recommend that you 
use X-Sync to create the backup for the data in your desktop computer. 
• Do not insert foreign objects in any of the openings, such as the stylus holder, Compact Flash 
expansion slot, or adaptor and phone jack. 
• Only use your stylus pen to press the reset button at the back of your device. Do not use other 
sharp object to press the button. 
• If your device gets wet or submerged in water, do not turn on the power as it may damage the 
product. If your device was completely submerged in water, it may not be repairable. Stop using the 
product immediately and contact the customer service center. 
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1 Introduction 
 

1.1 Welcome 
Thank you and congratulation on purchasing this product. 
This product provides all the support you need in your work and keeps you up to date with the latest 
information. 
 
With this product, you can : 

- check and adjust your schedule quickly and easily. 
(CH. 2 Personal Information Management System) 

- check your E-mail and download web pages. 
(CH. 3 : Internet Application) 

- be on time and on schedule wherever you are. The alarm function in Calendar can notify 
you of your meetings, departure/arrival times, business appointments, birthdays, 
anniversaries, and more. 
(CH. 2 Personal Information Management System) 

- save and update the information you need, and synchronize it with your PC. 
(CH. 9 X-Sync) 

 

1.2 What's in the Box? 
- Exilien 
- Cradle 
- AC Adaptor 
- Stylus Pen 
- Instollation CD 
- Earphones 
- Manual 
- Protective Cover 
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1.3 Components 

 
 

- Top Pnnel 
- Left Pnnel 
- Front Pnnel 
- Bottom Pnnel 
 
1. Speaker 
2. 4way direction key(Cursor-Pad) functions like the arrow-keys in a computer keyboard. 
3. Charging/ Communication Port connects to the Product cradle or serial/ USB cable, for 
charging the battery and/or communicating to a PC, another PDA, or serial/ USB device. 
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4. LED indicates the current process and the battery level. Alight comes on when you record a voice 
message or play a media file, and the light blinks when the alarm goes off. A solid light indicates the 
battery is being recharged. The light goes off when the battery is fully charged. 
5. Voice memo key(Recording Button) lets you record a voice message with Memo function 
6. AC Adaptor jack connects to an AC adaptor for an external power source. 
7. Power button lets you turn on/off the Back light without affecting the open applications 
8. Microphone for recording your voice message 
9. Stylus pen holder  for inserting the stylus pen. You can release the stylus pen from the holder by 
softly pushing the pen upward. 
10. IrDA for the wireless data transfer : Exchange data and applications with any infrared-enabled 
Palm that’s nearby. 
11. Compact Flash Expansion Slot for the Type-1 and Type-2 compact flash memory : Insert 
expansion cards to add additional applications or memory, or to back up your data. 
12. Phone jack : for the standard headphones 
13. Launcher key : the Launcher shows the open applications, and lets you move from one 
application to another. (functions like the ALT + TAB in Windows)  
14. Push-lever key : You can press the key to move in and out of a directory, launch an 
application, or open a file in an application(functions like the double click in Windows). You 
can also toggle the key up and down to use the key like the left and right arrow keys in a 
keyboard.  
15. Reset button : Push the button with the Stylus pen to restart the devices. 
 
COUTION : Pressing the reset button will erase any unsaved data. 
 

1.4 Cradle and AC Adaptor 
Your device package includes an AC adaptor, and either a cradle or cable for synchronization. 
You can set your device on the cradle to recharge and synchronize your device to your PC.  
 
Cradle 
a. Interface connector connects the cradle to your Exilien. 
b. AC Adapter jack 
c. USB Cable connects to your PC 
d. Serial Cable (optional) connects to your PC. 
 
Adapter 
a. Plug  
b. Adapter jack 
 
Recharging the Battery 
Your device consumes small amount of power to maintain RAM and the clock; therefore, the 
rechargeable Lithium ion battery in your device should be recharged regularly. 
If the battery gets very low, it acts in a backup mode, in which case, the device turns itself off 
in order to protect your unsaved data. The backup battery lasts for about a week before 
shutting down and erasing your unsaved data. Because most of the applications and data you 
install on your device are stored in memory, you need to reinstall them if the battery discharge 
completely.  
 
Installation (AC adaptor/ PC connection) 
Connecting to a power source :  

1. Place your device in the cradle. 
2. Connect the adaptor to the adaptor jack 
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3. Plug the adaptor into any AC outlet. 
You can also use the AC adaptor to connect the aroduct directly to an external power sourse. 
 
Connecting to a PC :  

1. Place your device in the cradle. (Refer to No.1 in Connecting to a power source) 
2. Plug the USB connector into a USB port on your computer. 
3. Plug the AC adapter into any AC outlet. 

  
Caution: Only use the adapter included in the package. 
 
When charging the battery, the battery charging status. For example, the charge light comes 
on when the battery is being recharged and the light goes off when the battery is fully charged. 
 
Troubleshooting 
The charge light does not come on. 
when your device is connected to the cradle: 

1. Make sure the cradle is plugged into an outlet. 
2. Make sure the bottom of your EnDA is pushed firmly into the cradle. 

1.5 Using CompactFlash Expansion Slot 
The device supports Type I and Type II Compact Flash cards. The Compact Flash slot allows 
you to install storage cards for backup and storage for your data and applications when it is 
inconvenient to perform a X-Sync operation.   
 
To insert a CompactFlash card  
1. Hold your device securely and remove the CompactFlash slot cover. 
2. Make sure the card is facing the correct direction and carefully push the card into the slot 
until it stops. 
 
Use your thumb to push the card into the CompactFlash slot. When you feel the card lock, the 
card is properly seated within the slot. 
 
3. If the device does not recognize the card, check again for the direction of the card.  
 
To remove a CompactFlash card 
1. Quit all applications with open files saved on the CompactFlash card. 
2. Hold your device securely and carefully pull the CompactFlash card out of the slot. (Refer 
to No. 1 in To insert a CompactFlash card) 
 
Your device comes with a dummy card seated within the CompactFlash card slot. To prevent 
debris from entering and damaging the slot, we suggest that you leave the dummy card seated 
when you are not using a CompactFlash card. 
 
Guidelines for Using CompactFlash Cards 
This Product recognizes many different types of CompactFlash cards. If a manufacturer of a 
specific CompactFlash card instructs you to install a specific driver for this Product, you must 
install the correct driver specifically designed for the device’s operating system. If you are 
unclear about installation instructions, follow the documentation that accompanies or ask your 
CompactFlash card manufacturer for more information. 
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• Some CompactFlash cards consume large amounts of power. To avoid the complete 
drainage of a battery when using a CompactFlash card, connect your device to AC power 
wherever possible. 
• If the battery is very low, do not save data to a CompactFlash card. This may result in the 
loss of data. First connect to AC power. 
• Do not turn off your device or remove the CompactFlash card when you are in the middle of 
performing an operation, such as saving data to your CompactFlash card. 
• Keep your CompactFlash card in a protective case when not in use to protect it from dirt and 
moisture. 
 

1.6 Using the Stylus Pen 
This device has many of the same functions as a portable personal computer, but does not 
have a keyboard or a mouse. This device’s main input method is a highly sensitive touch-
screen LCD display. You can execute, access, and input information through the touch-screen, 
and use the Stylus pen like a mouse on a PC. The Stylus pen will help you control the touch-
screen more easily and effectively without damaging the touch-screen. 
 
Do not use your finger or other object on the touch-screen. 
The stylus tip can also be used to press the reset button. 
 
Tap : softly touch the screen once with the stylus to select or execute a file or command. Tap 
works like a mouse click. 
Drag : Hold the stylus on the screen and drag it across the screen to select text. 
Tap and hold : Tap and hold the stylus on an item to see a list of actions available for that 
item. Tap the action you want to perform on the pop-up menu that appears. 
 

1.7 The Basics 
 
This product will help you stay organized and on time, and keep up with your daily tasks while you are 
away from your office. Use your new this product to do the following: 
- Enter your schedule in the Schedule, and set an alarm to remind you of important meetings. 
- Keep all your contact names, addresses, and phone numbers in Address. 
- Prioritize and assign your tasks a due date in ToDo. 
- Jot quick notes directly on the screen in Memo. 
- Synchronize your data with X-Sync software on your PC so you always have a copy. 
- Insert expansion cards to add additional software or memory, or to back up your data. 
- Beam information to another device that is close by and has an IR (infrared) port. 
 
Touch-Screen Calibration 
The first time you turn on the device, you will find the Calibration program on the screen. You need to 
tap the center of crosses(+) that appear at upper right, upper left, lower left, and lower right corners, and 
in the middle of the calibration screen.  
 
Main Window 
After you have finished with the calibration, the main window appears. You can open an application or 
folder by tapping on the corresponding icon on the main window. You can move to the upper directory 
by tapping on the icon (a or b) 
 
Adjusting the screen 
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If lighting conditions make it difficult for you to see the information on your device, you can use the 
Brightness (Setup>System>Brightness) to adjust your screen.  
Note: You can also set your device to automatically turn off the backlight after a period of inactivity 
defined by the Brightness setting. See “Brightness” later in the “System setting” chapter for details. 
 
Resetting 
If your device does not respond to buttons or tapping the screen, you need to perform a reset to get your 
handheld running again. Use the stylus pen to gently press the reset button inside the hole on the back 
panel of your device. 
 
Main Window 
Today 
You can tap on the icon to open Today.  
You can read and study the important information and schedules for the day, and examine the status of 
device. 
 
Date & Time setting  
You can open Date & Time setting by tapping on the icon, and change and reset the date and time. 
 
Power  
Power management shows the current level of battery. You can set the energy saving mode. 
 
The basic configuration of the folder is as follows  
Application-----Text viewer  
Game-----Minesweet, Solitaire, Tetris  
Internet-----E-mail, Atilla  
Multi Media-----Image viewer, MP3 Player, Media player  
My Document   
Setup-----Network---Network, PPP 
Setup-----Personal---Alarm, Owner, Password 
Setup---System---AppLinker, AppRemover, Backup, Brightness, Calibrate, Power, Rotation, Sync, 
System, TaskManager, Time, Volume 
Utility-----Calculator, File Browser, Terminal, WClock  
Address 
Memo 
Search 
ToDo 
Schedule 
 

1.8 Input 
This product supports both Korean and English. You can enter letters, symbols, and numbers, and draw 
pictures on your device by : tapping(not typing) on the Screen Keyboard, writing with the stylus on the 
Character Recognition Window, and drawing with the stylus in the Memo application. You can open the 
Screen Keyboard or Character Recognition Window by tapping on any area with a blinking cursor. If 
you locate an area where you want to enter characters, tap on the area and the input panel will appear at 
the bottom of your screen. You can start drawing pictures in the Memo application by tapping on the 
drawing icon at the upper left corner of the screen.  
 
Using the Screen Keyboard 
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The Screen Keyboard is similar to a keyboard you use on your PC, except that you have to tap instead of 
type. If the Character Recognition Window appears, shift to the Screen Keyboard by tapping on the 
Screen Keyboard button at the lower right corner of the Character Recognition Window.  
The Screen Keyboard consists of the following items  
1. the upscroll and downscroll buttons on top of the keyboard for scrolling the main screen, bottom of 
which is blocked by the Screen Keyboard, 
2. the close button at the top right corner of the keyboard for closing the Screen Keyboard, 
3. the character keys including Korean, English, special characters, and arrow keys 
4. the shift button on the right of the space bar for shifting between English and Korean. 
5. another shift button for shifting to the Character Recognition Window. 
 
Tapping the character keys  
1. You can tap on the keys with the stylus just as you would type with your fingers on your desktop 
keyboard. 
2. The Shift and Caps button for accessing the capital letters and symbols work the same as your normal 
keyboard.  
3. Use Esc to move out of the current editing window. 
 
Making and editing text selections  
1. You can make a selection from the text by dragging the stylus across where you want to select.  
2. You can tap and hold on the text window to open a pull down menu with functions : Undo, Redo, Cut, 
Copy, Paste, Clear, and Select All. These functions on the pull down menu work exactly the same as the 
ones on Windows.  
 
 
Using the Character Recognition Window 

  

 
 
 
Your device is equipped with a powerful character recognition engine to convert your handwriting into 
typed letters accurately and efficiently. The character recognition engine supports the following character 
sets. 
Korean : 2,350 characters ( some characters not supported ) 
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English : 26 characters ( capital and lowercase letters ) 
numbers : 0 ~ 9 
symbols : 32 symbols on keyboards   ̀  ~ ! @ # $ % ̂  & * ( ) - _ = + \ | [ ] { } ; : ' " , . < > / ? 
motion input methods : special characters such as Space, Tab, Backspace, Enter 
 
If you want to use the character recognition window, you only need to tap on an area where you want to 
write on. Then, the character recognition window appears at the bottom of the screen. If the Screen 
Keyboard appears, shift to the Character Recognition Window by tapping on the Character Recognition 
Window button at the bottom of the Screen Keyboard, left of the arrow keys.  
The character recognition window consists the following items : 
the upscroll and downscroll buttons on top of the keyboard for scrolling the main screen, bottom of 
which is blocked by the Character Recognition Window,  
two input panels for you to write on alternately 
four buttons on the left of the input panels 
-Space, Backspace, Enter, and Tab buttons.  
-six buttons on the right of the input panels 
1. a button for shifting between Korean and English recognition panels 
2. a button for closing the Character Recognition Window 
3. a button for shifting to the number recognition panels 
4. a button for shifting between the capital and lower case letters 
5. a button for shifting to the symbol recognition panels 
6. a button for shifting to the Screen Keyboard 
 
Writing characters : 
Choose the input panels for English, Korean, numbers, or special characters, and then, choose between 
the upper or lower case for English. 
Write one character at a time and use both of the input panels alternately. 
 
Tip : Your device recognizes your handwriting more efficiently if you write in big letters clearly and 
slowly without scribbling. 
Use the motion input methods for special characters. 
Motion input methods  
 
Making and editing text selections : 
You can make a selection from the text by dragging the stylus across where you want to select. You can 
tap and hold on the text window to open a pull down menu with functions: Undo, Redo, Cut, Copy, 
Paste, Clear, and Select All. These functions on the pull down menu work exactly the same as the ones 
on Windows.  
 
Drawing Pictures on the Memo application 
Open the Memo application 
Tap on the drawing icon on the top left corner of the Memo window 
Start drawing with your stylus pen. 
You can tap on the eraser icon at the top left corner of your Memo window, and erase your 
drawing with the stylus 
You can also tap on Clear All button at the top right corner of your Memo window to erase 
everything on the screen at once. 
 

1.9 Backup and Restoration 
 
Data Backup and Restoration 
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To avoid losing your data in the event that your device is lost, stolen, or becomes defective, 
periodic backups to your PC or a CompactFlash card is recommended. Depending on your 
usage, you may want to perform a backup as often as once a day. 
You can backup and restore your data with the following methods: 
 
Using X-sync  
You can use X-sync to periodically backup your data in this device onto the hard drive of 
your PC. You can backup data yourself or set X-sync to do it for you every time you connect 
your device to your PC. For more information, see Ch.6 X-sync 
 
Using Backup menu 
select set up > system > back up  This utility create backup for everything including the contact 
list in Exilien's memory, onto a CompactFlash storage card (purchased separately) or onto a 
hard drive in your PC. 
 
To Backup data to a CF card      
Each time you use the Backup utility, your data files, databases, preferences, X-Sync system 
data, and applications are copied to the CompactFlash storage card. 
 
Backup is designed for use with CompactFlash storage cards that are approved by Microsoft 
as Windows CE compatible. You should use a card at least as big as this device 's RAM size, 
e.g., 16 or 24 MB.  
 
1. Connect to external power, or tap and open Power to verify that the battery has a charge 
rating of 20% or greater--CF card consumes much power from your battery. 
2. Install the optional CompactFlash storage card on your device, as described earlier in this 
chapter. 
3. Close all active programs. 
4. Select set up > system > back up, and check all the items that will be backed up. You can 
verify the data and size of the items that will be backed up. 
5. Select CF card as the destination of the saved items. Tap the Start button to begin the 
backup process. 
6. When backup is complete, remove the CompactFlash storage card and keep it close for 
easy retrieval. 
 
To restore the backup data onto your device: 
1. Insert the CompactFlash storage card with the backup data in your device. 
2. Turn on the product, Close all active programs. 
3. Select set up > system > back up  
4. Tap Restore on the screen. 
5. Select the items to restore as the same way you selected items for backup. Tap the Start 
button to begin the restore process. 
 
Do not remove the CF card, or turn off the unit during restoration as it result in the loss of 
data. 
 

2 Personal Information Management System 
 
The first time you turn on your device in the morning, or after you initialize the settings for your device, 
you will find the Today icon on the upper left corner of the screen.  
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Today lets you manage your schedule, upcoming appointments, to-do lists, contact information, 
anniversaries, and upcoming event. Today also indicates any new e-mail messages that you have 
received today.  
 

 
2.1. Today 
To open the Today application, tap on the Today icon at the top left corner of the main screen.  
 

1. Today shows the owner's information, scheduled events and appointments for the day, 
to-do list, birthday, and number of new e-mail messages, all of them at once. You can 
tap on a specific item to open the corresponding application and view or/and edit the 
item in detail. 

 
2. Tap on the icon of the Today's upper tool bar to open the Option window. You can 

select the checkbox next to each item that you want to see on the Today's window. 
 
 

 
 

3.   You can tap on the Day/Week button to view a pull down menu. You can choose to 
show events, schedules, birthday, to-do list, and mail counts for one day or one week in 
the Today's window. 
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2.2 Schedule ( ) 

 
 
Managing your meetings and appointments: 
You can make a list of meetings, events, appointments, anniversaries, and manage your schedule with 
the Schedule. You can set an option to view your schedule for one day, 5 days, a week, or a month at a 
time. You can categorize your schedule to suit your needs. You can synchronize and update the contents 
of the Schedule with Microsoft Outlook on your PC. 
 
Tap on the icon to open the Schedule. 

 
1. To add a new item on the Scheduler, move to the date of an event or appointment, and select the time 
of the event or appointment by dragging the Stylus pen from the starting time to ending time.  
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2. Once you set the date and time of an event for scheduling, tap NEW icon  to create a new event. The 
editing window for the new event will show the date and time you have selected with your Stylus pen. 

 
3. Enter the title for a new event. If you tap on the pull-down menu next to the title box, 5 pre-defined 
titles appear. These include a 'Meet with', 'Lunch', 'Dinner', 'Visti', and 'Call'. 

 
4. You can choose one of the 5 titles or make a new title yourself. 
 
5. Type is located right below the Title. If you tap on the pull-down menu on the right, 5 types of events 
appear. These include 'Appointment',  'Meeting', 'Telephone', 'Others', and 'Anniversary'. Choose the type 
that is most suitable to your event. 

 
6. If you want to change the time of your scheduled event, tap on the pull-down menu next to the Starts 
and Ends button and select the corresponding times. 

 
7. If you want to set an alarm for an event, select the check box next to Remind me, and set the date and 
time for the alarm to go off before the scheduled event. 
 
8. Enter additional information about the scheduled event on the Memo. 
 
9. You can tap on the Attendant button to select the people, who will attend the event with you, from the 
list of people in the Address program. 
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10. If the event is held regularly, select the Repeat button. You can choose the interval of the event from 
every day, week, and month. You can select the beginning and ending date of the repetition, or the total 
number of  repetitions. 

 
11. You can select the All Day check box  for an event that lasts all day or does not have a set time for 
beginning or ending. 
 
12. You can categorize, change, and edit scheduled events. You can create, edit, or delete a category by 
tapping on the category button located below Closing button at the upper right hand corner of Schedule. 
 
13. The following image is an example of a day's scheduled events. You can find an all day event at the 
top of the screen, and differentiate the types of events by their colors. 

 
14. If you tap the icon, you can see the scheduled events of a week except Saturday and Sunday's. 

 
15. If  you tap the icon, you can see the scheduled events of a week including Saturday and Sunday's. 

 
p. If  you tap on the icon, you can see the scheduled events of a month. 
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17. If you tap on the icon,  you can see a list of all the scheduled events for each category. 
 
18. A square icon,  will identify that an event is scheduled for that day. You can tap on each event and 
read the detailed information about the event. 

2.3. Address ( ) 

 
You can manage the addresses of your friends, family members, business partners, and 
acquaintance. You can record the name, position, address, phone number, email address, fax 
number, mobile phone number, birthday, and any information about the person, and 
synchronize and update the information with the address book in the Outlook program on 
your PC. The Address program also provides you with the fast search function for the 
addresses. 
 
Tap the icon on the main screen to launch the Address application. 
 
Entering new information 

1. Tap the New button at the menu bar to create a new record.( ) 
 

2. Tap the area where you want to enter data. 
 

3. Type data using the onscreen keyboard or the handwriting method. 
 

4. You can change the order of the listed information. You can set the address for the 
first item on the list, or the mobile phone number or any other category for the first on 
the list. Tap on the pull down menu for the categories and change the order for the list.  
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5. After you finished entering all of the informaiton, tap the OK button 
 
6. The new record is displayed at the main screen of the Address.  

 
 

Edit the recorded information( ) 
1. Tap the person whose information you want to update. 
2. Tap the screen where you want to update. 
3. Type the data using onscreen keyboard or handwriting. 
4. Tap the OK button. 

 
 
Cancel the editing 

1. Tap the Cancel button during NEW or EDIT operation. 
2. Device displays address book list view windows. 

 
Deleting contact information( ) 

1. Select a contact to remove from the record. 
2. Tap the Delete button. 
3. A dialogue box to confirm the delete command will be displayed. 
4. Tap Yes button. 

 
Displaying the records 

1. You can change the order of the list in ascending or descending order by tapping on 
the Name category from the list. You can tap on the Contents box, and choose which 
content is displayed on the list. 
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2. Tap on each record to view all the data. 

 
 

3. Each item on your record is synchronized with the related application. For example, if 
you tap on the homepage address of a person, your default web brower, Atilla, will 
lauch automatically and open the web site for you. If you tap on the e-mail address on 
the record, your default e-mail program will launch automatically. 

 
Searching a string in the address book( ) 

1. Tap search button on the menu bar or select search under the edit menu on the title bar. 
2. Tap the search characters using onscreen keyboard or handwriting. 
3. Tap the find button 

 

2.4 To Do 
1. To Do is a convenient place to create reminders and prioritize the things that you have 

to do. 
2. Tap the Todo icon on the main screen to launch the application. 
3. To add a new ToDo item, tap on the icon on the upper tool bar. 
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4. Enter data in the boxes. Enter the title and beginning and ending date, and date and 
time for notification. 

5. Tap on the Status to open a pull down menu. You can display the status of the 
progress on your task from the menu. 

 
6. Tap on the Priority and choose to display the importance rate of your task from the 

pull down menu. 

 
7. If you finish entering information, tap on the O.K button and save the data.  
8. Your ToDo records are displayed in the main window of the ToDo application. The 

order of the list is determined by the priority of the tasks. The high priority is indicated 
with a red, the normal with a blue, and the low with a green exclamation mark. 

 
 

9. You can mark the checkbox on the left of a ToDo item to indicate that the task has 
been completed.  

10. Tap on the icon of the upper tool bar to display only the unfinished taks.  
11. Tap on the title bar to open a pull down menu. You can change the order of the list by 

the status, priority, title, or due date of the tasks. 
 

2.5 Memo 
You can take notes on your device with your stylus pen as you would write on a note pad with 
a pen.  
 
To create a  new note 

1. Tap on the Memo icon in the main window to launch the Memo application.  
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2. Tap the icon ‘New’ button.( ) 

 
3. Enter data using the onscreen keyboard or the handwriting method. 

 
4. Tap the OK button to save the note. 
 
5. You can manage each item by its category. Assign a category by choosing from the 

pull down menu on the right corner of the upper tool bar. You can also create a new 
category or modify the existing categories. 

 
Reviewing the notes 

1. Tap on a item from the list. 

 
2. Edit the data using the Screen keyboard or Character Recognition Window. 
 
3. Tap the OK button to save. 

 
Deleting an item from the list 

1. Tap the memo you want to delete in the Memo List 
2. Tap the delete icon.  



 

22 

3. Tap the OK button in the Delete Memo dialog box. 
 
Using the Voice Recorder and Drawing Pad  
The Memo supports different types of data such as image, voice recording and writing. You 
can enter the necessary information using the Screen Keyboard, Character Recognition 
Window, Voice Recorder, or Drawing Pad 
 

1. Tap the icon ‘New’ button.( )  
2.   There are two icons for the Drawing Pad and Voice Recorder on the left of the tool bar  
 

Using the Drawing Pad 
The Memo supports different types of data such as image, voice recording, and writing. You 
can enter the necessary information using the Screen Keyboard, Character Recognition 
Window, Voice Recorder, or Drawing Pad. 
 

3. To draw, choose the left icon of the upper tool bar and open a new window for 
drawing pictures. Start drawing with your stylus pen.  

 
 

4. Tap on the eraser icon at the top left corner of the window. You can erase the drawing 
with the stylus pen.  

5. You can also tap on Clear All button at the top right corner of the window to erase 
everything on the screen at once.  

 
Using the Voice Recorder 

6. To record your voice, choose the speaker icon on the tool bar.  
7. The recording process is displayed at the bottom of the screen 
8. Tap on the play button to start recording. 
9. Tap on the stop icon to finish recording.  

 
10. Tap OK button to save the voice recording  

An icon indicates the type of data for each item on the list.  
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11. Tap on a memo to view in. 

 
12. Tab the clip icon to view the attachments to a memo. 
 
13. Tab the image or speaker icon to view or listen to the attachments. 

 
 

3 Internet Application 

3.1 Web browser 

 
 

Atilla is an internet browser that supports HTTP1.0 protocol and uses HTML4.0 documents. 
 
You can surf the internet with Atilla. Atilla also supports Java Script, so you can use this 
browser as you would with a browser on your PC.  
 
To open Atilla, tap on the icon [Internet] -> [atilla] on the main screen. 
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1. Atilla opens the first page which you can setup in the option window. 

 
2. Tap on the icon of the upper tool bar to view the larger browsing window without a 

title bar or address input box. 

 
3. You can bookmark web sites  by tapping on the Bookmarks pull down menu on the 

upper tool bar. 

 
4. Select the Add Bookmarks to add a new bookmark for the current page. Enter the 

URL and name, and tap the O.K button. 
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5. Tap on the [Option] button to modify the settings for Atilla. You can change the 
options such as the default page and language encoding. You can also choose whether 
to enable JAVA script for Atilla or not. 

 

3.2 Email 
 
Email lets you manage the e-mail messages that you send and receive through the e-mail 
application on your PC. You can compose a new e-mail message, read the messages that are 
stored in your device. To send and retrieve messages, you need to use X-Sync to synchronize 
your device.  
 
Note: Before using Email, you must set up X-Sync for use with an e-mail application on your 
PC. 

 
 
First, you’ll need to install X-sync on your desktop computer. 
Follow the following installation procedures to install X-sync, connect your device to your 
desktop computer, and establish a partnership for synchronization. 
 
If you open Email, you can see a list of messages you have received. Tap each message to 
read it.  
If you want to send an e-mail message, touch the send icon on the left of the tool bar 
 
You can use Email on and off line. The offline mode is without the connection to the internet. 
The online mode is with the connection to the internet. 
 
In the off-line mode, you can read your e-mail messages that you have saved in your device 
with X-Sync. 
In the on-line mode, you can send and receive e-mail as you would with your PC. 
Tap the icon  Internet -> Email to open. 
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 Off-line mode in  Email 

1. In the off-line mode, you can not send an e-mail message directly from your device, but 
can read e-mail messages that you have acquired by synchronizing with your PC with X-
Sync. In the off-line mode, tap the checkbox from the list on the main screen of X-Sync. 
 
2. If you tap the first icon of X-Sync’s tool bar, e-mail messages from your PC are 

synchronized with the Inbox in your device. 
 
3. After synchronization, you can see that the new messages from the Outlook are saved 

on your device 's Inbox. 
 

 
4. You can read the content of the e-mail messages by tapping the item with the stylus 

pen. 

 
 

The descriptions of  the functions in Email are as follows : 
: To reply to the sender of the current e-mail message 
: To reply to everyone related to the current message. 
: To forward the current message to another person. 
: To read the previous message. 
: To read the next message. 
: To delete the current message. 
 

5. The pull down menu at the upper right corner of  E-mail window shows types of mail 
boxes for the stored messages. You can see the name of a mail box for the list of 
messages that are currently visible on the window. You can add or delete a mail box, 
and edit the names of mail boxes. The functions for each mail box are as follows:  
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Inbox  
If you synchronize your device with MS Outlook through the use of  X-Sync, X-Sync copies 
the mail messages from the Inbox of Outlook. 
Sent 
A place to save mail messages that have been sent. 
Outbox  
In the off-line mode, the new messages are stored here temporarily. When your Exilien is 
synchronized with your PC, the messages are sent out by the Outlook program on your PC.  
X-Sync 
A folder that is synchronized with X-Sync folder of the Outlook on your PC. X-Sync folder is 
created automatically when the device is synchronized with a PC. 
 

6. To make a new message off line. Tap the first icon of the upper tool bar on the main 
window. 

 
7. On the From section of the upper tool bar, the sender’s e-mail address is displayed 

automatically. This mail address is your e-mail address that you can enter at Setup-> 
Personal-> Owner. 

 
8. Tap the To section to display a list of e-mail addresses from the Address application. 

You can simply select the e-mail address of the receiver. You can manually enter the 
e-mail address of a person who is not on the list.  

9. Tap the Attach button to view the Open File window. Choose a file that you want to 
attach to your e-mail message. 

10. Write the subject and contents of a message, and tap the O.K button on the upper tool 
bar to save. 

11. The message is automatically saved in the Outbox folder, and will be sent out the next 
time you synchronize your device with your PC. 
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On-line E-Mail 

1. When you are on line, you can write and send e-mail messages, and receive new 
messages as you would with an e-mail program on your PC. To set up an e-mail account, 
choose [Option] from the main menu at the top left corner of the main window of the 
program. 

 
2. Tap the New icon of upper tool bar. 
3. The setup window for a new e-mail account is displayed. Enter information on the 
corresponding sections for your e-mail service provider. Your device supports both 
IMAP4 and POP3 protocols. Tap O.K button to save the data. 

 
4. Tap to open the Configuration Window from the upper tool bar.  

 
You can configure your e-mail service to do as follows :  
* Receive only new messages : receive only new messages from POP3 and IMAP4 server. 
* Receive only headers : receive only the headers of the messages--this works only for a 
POP3 server. A message is stored in your POP3server as long as you do not tap on the header 
and read the message. Once you tap on the header to open the message, the message is 
transferred from the server to your device. 
 
Note : IMAP4 transfers only the headers of e-mail messages. 
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* Remove the messages you have read from the server : this is only for a POP3 server. A 
server removes messages after transferring them to your device.  
* Limit message size to : You can set the size limit of your e-mail messages. Your device 
does not receive a message from the mail server, if it exceeds the limit you have set. 
* Encoding : Setting for the character encoding. 
 

5. After saving a message, choose the icon from the upper tool bar to send or receive an 
e-mail message. 

 
Writing method is the same as the off-line mode. Tap O.K button to save a message. The new 
mail message is saved in the Outbox of the mail server. The Email application automatically 
sends or receives messages when your device is connected to the internet or synchronized 
with PC. 

 

4. Application 

4.1 Text Viewer 
Text Viewer is an application that can read *.txt’s documents. You can read text documents 
such as novels, newspaper articles, tidy documents, etc. that were downloaded from your PC 
or the internet. 
 

1. To open the Text Viewer, choose Application -> Text Viewer on the main screen. 

 
2. At first a blank screen appears.  

 
3. To open a new text file, tap from the upper title menu or tap the icon from the upper 

tool bar. Then, the Open File window is displayed. Tap the checkbox of a text file that 
you want, and tap O.K button at the top right corner of the screen.  
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4. You can turn the pages of a text by pressing the Cursor key or tapping on the upper or 

lower area of the screen. You can tap the button from the upper tool bar use auto-
scroll function. To stop the auto-scroll function, tap the same button again. 

5. You can move the slide bar to move to any location in the document 
6. Tap the arrow icon to set up a bookmark at the present location 

 
7. Tap the from the title menu to change the size of the screen, font size, text color, 

background color, and the speed of the auto scroll function. 

 
 
 

5 Multimedia 

5.1 Media Player ( ) 
You can play MP3, MPEG-1 and MPEG-2 files. After playing, you can see some contents 
such as index no. of MP3 file, the status stick of play, Play/Pause/Stop button icons, etc. 
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This chapter introduces you the media play technology, and explains general overview of 
media player. The media player stores your favorite MP3 and MPEG files in its flash memory 
so that they can be played any where you want to go. 
 
The device equipped with USB port to communicate with your desktop computer. You can 
download MP3 files to the device from your desktop computer using the X-sync software. 
You can download MP3 music files from numerous Internet sites or encode your own digital 
audio tracks from your own audio CDs using the CD-ROM drive on your PC. 
 

1. Obtain legal MP3 files from many MP3 Internet sites. 
2. Use the X-sync to download your MP3 files into the your device. 
3. Press the Play button on the your device to listen the digital sound. 
 
Operating Media Player 
Start 
Tap Media player icon in Multimedia folder. 

 
Media File Listing 
Tap to open MP3 Music Selection window. 
All media files in your device are displayed in the window. 
Check desired songs, or tap ‘Select All’ button to select the entire list.  
Tap ‘Close’ button to return the media player. 

 
 
Play 
Tap the track number you want to listen, or 
Tap the play button in standby or pause mode to start playing selected MP3 file. Operation 
indicator displays in play mode. 
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Pause 
Tap 
It becomes pause mode by tapping in play mode. Operation indicator displays in pause 
mode. It resume the play by tapping again. 
 
Stop 
Tap 
Stops playing MP3 file and reset play time counter when the MP3 player is in stop mode. 
The information of current music is displayed in new window. It displays title, musician 
name, album name, creating year, genre, track number, and comment. 
 
MP3 Player Track Shift 
Tap 
Media Player is an application that plays multimedia file. Media Player plays MPEG and 
MP3, and because it support Skin function, user can use only user own Media player by 
user’s mind. 
 
1. In order to operate Media Player, choose Multi Media -> Media player at main screen.. 
2. In order to make a play list, tap the play list button of the left of lower. 
3. Play List is displayed. Tap the icon of upper tool bar to add new media file to Play list.. 
4. After choice of media file that user want, tap check box of file name. If user finish all 

choice, tap O.K button of the right of upper to close Play list screen. 
5. User can see the file chosen that user want to play. Tap check book of file name to 

play the file that user want only. 
6. Play status of chosen file.  

 
7. If user tap the title icon of the left of upper, menu is displayed and user can set up 

repeat play, random play, Skin setting of Media Player, etc. 
 

5.2 MP3 Player ( ) 
MP3 Player works much the same as the Media Player except that the MP3 Player can 
only play MP3 sound files. 
 
Note : Media Player and MP3 Player may not work properly on a device with fewer than 
32MB of SDRAM. 
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5.3 Image Viewer ( ) 

 
You can see image files such as JPG, GIF file, etc on the window and there are functions such 
as image enlargement, reduction and rotation. 

 
Image Viewer is an application that be able to display JPEG/GIF image file. User can enlarge, 
reduce, and rotate of image. Also, this application is including Full size view, slide show and 
wallpaper, etc. It is same as portable digital album. 
 

1. In order to operate Image Viewer, choose Multi Media -> Image Viewer at main 
screen. 

 
2. If user operate Image Viewer, blank screen is displayed. 

 
3. In order to open image file at Image Viewer, choose Open menu of main title bar or 

tap the icon of upper tool bar. Then, file viewer is displayed and user can choose the 
image file that user want to view. Tap check box of each image file and tap O.K 
button of the right of upper. 

 
4. The first image of chosen files is displayed. 
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5. If user chose several images, user can move backward and froward and see the images 

by tapping upper tool bar. 
6. If user tap the button of upper tool bar, use can enlarge and reduce image size. 

Enlargement is available by maximum three times, reduction is available by minimum 
size that screen can display on LCD.  

     
7. If user the button of upper tool bar, user can rotate an image.  The rotation is 90 degree 

per one tapping of rotation button to time running direction. 

 
8. If user tap the button of upper tap, current displayed image is enlarged. If user want to 

restore the image to its former state, tap screen two times. 
9. If user tap the button of upper tool bar, chosen images are displayed by slide show to 

fit whole screen size in order. 

     
There are several setting menus at upper menu. 

 
10. If user tap Wallpaper Setting, user can set up the current image as wallpaper. 
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11. If user tap Options, user can control several setting that are used for image display and 

slide show.  

 
12. If user choose Fit to Fit of Display, user can set up that an image is fit to screen if the 

image size is bigger than screen’s. 
13. If user choose SlideShow option, user can set up slide show’s rotation speed, rotation 

effect and image’s size to fit screen’s. 
 
Note. Image Viewer may not work properly on a device with fewer than 32MB of 
SDRAM. 

 
 

5. 4 Game 
Device is including several fun games in basic and user can download and install other 

games by internet. 

 
Minesweep 
The object of Minesweep is to locate all the mines as quickly as possible without uncovering 
any of them. If you uncover a mine, you lose the game. 
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Solitaire 
The object of Solitaire is to use all the cards in the cards in the deck to build up four suit 
stacks in ascending order, beginning with the aces. 

 
Tetris 
The object of the game is to keep the blocks from piling up to the top of the game field. To do 
this, you can move the blocks to the left and right, and rotate them as they fall. If you can 
completely fill in one horizontal line, that line disappears and you get points. If the blocks pile 
up to the top of the game field, that’s the end of the game. 
 

 
 

6. Utility 
  

6.1 Calc ( ) 
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Calculator enables you to perform addition, subtraction, multiplication, and division. Your 
device provides a Standard Calculator with a graphing feature. 

 
 
AC  : Clears the entire calculation and enables you to begin a fresh calculation.  
C : Clears the last number you entered. Use this button if you make a mistake 

while entering a number in the middle of the calculation. This button enables 
you to re-enter the number without starting the calculation over. 

MC : Clears any value that is stored in the Calculator memory. 
MS : Store current value to memory. 
M+ : Places the current number in memory. Each new number you enter with the 

M+ button is added to the total already stored in memory. The number that you 
add can be either a calculated value or any number you enter by pressing the 
number buttons. Pressing this button has no effect on the current calculation 
(or series of calculations); it merely places the value into memory until it is 
recalled. 

MR : Recalls the stored value from memory and inserts it in the current calculation. 
% : Convert % value to real number(10%=0.1) 
+/- : Toggles the current number between a negative and positive value. If you 

want to enter a negative number, enter the number first and then press the +/- 
button. 

6.2 Terminal ( ) 

 
For function to choose and to set input console mode – you may use the general Linux 
commands as ls, cd, vi, and cat in the console. 
 

6.3 File Browser ( ) 
You can browse files in directories 
 

A file browser that can manage directories and files in device 
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6.4 Wclock ( ) 

 
You can see world time of which you want to know. 
You can view the day and time for other cities anywhere around the globe by just tapping the 
city on the world map. 
A utility that display three places’ local time in one screen. If user choose a place that user 
want to know the local time, the current local time of the city is displayed at lower. The map 
of Wclock could be displayed at two step by enlargement, then user can see and choose the 
city in detail. 

 
 

7 Search ( ) 

7.1 Search ( ) 
Text Viewer is an application that can read *.txt’s documents. You can read text documents 
such as novels, newspaper article, tidy documents, etc. That were downloaded your PC or the 
internet. 
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S/W for searching files and name at the upside of left when window is opened.You can 
search contents among all(searching all data), address,  schedule, to do, memo and file. 

 
 

8 Customizing your device 
 
In order to use device easily and conveniently, user have to set up options according to user’s 
likings and environment. In addition, user can set up options to connect internet by network 
and telecommunication environment, it is available to be convenient for security of private 
information and system by password setup. These system setup is available by checking the 
setup icon in Main screen. 

8. 1 Network setting 
The Network setting enable you to use the TCP/IP software that is included in the device 
operating system. You can use the TCP/IP software to connect with Internet Service Providers 
(ISPs) or dial-in (remote access) servers. Because the TCP/IP software is a feature of the 
operating system, you configure all parameters relating to it from the setting. 
To use TCP/IP, you must configure both the Modem and the Network settings. 

 
Network setting 

1. Network setting is divided into Network and PPP. User who use Ethernet card in LAN 
(Local Area Network) environment  choose Network, user who use telephone modem 
choose PPP. 

2. LAN environment’s user choose Network, input IP address and Gateway, DNS, etc. 
manually. Especially, if user is assigned has Host name, Domain and IP address, 
choose User Specific IP Address, input exact data respectively. If it is DHCP 
environment which use IP address allocated automatically, choose Use Server-
assigned IP Address, then user do not need to input specific data to use internet. If user 
do not know network information, inquire network information to network manager. 
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Note: There are a lot of Network devices available for your device. Before attempting to 
set network, refer to the guide book that accompanies. For more questions and support, 
please contact the device developer directly. 
 

PPP setting 
1. In case of user who use Modem, choose PPP and set up PPP environment (network by 

telephone). There is blank screen when PPP is chose. For the sake of new PPP setup, 
choose [File] -> [New]. 

 
2. New PPP  setup screen appears. Input data to meet ISP at each item. If  you do not 

know input-data, inquire exact data to ISP. After finishing data input, click O.K button 
and close PPP setup screen. 

 
3. Modem setup installed at device is set up at [File] -> [Option] of PPP Main screen 

menu or set up to tap the icon of upper tool bar regarding modem install port, modem 
information, initialization commander, etc. After finishing all data input, click O.K 
button and close setup screen. 
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4. After finishing setup, summarized contents of PPP setup is displayed. Click the first 
icon of upper tool bar, then dialing and PPP connection is configurated. 

5. In case to Modify, remove PPP setup or add new PPP environment Setup, click the 
right icon of the upper tool bar. 
?1  Tap on the icon and select NEW to add a new PPP setup 
?2  To edit or delete a PPP setup, select the PPP setup, click on the icon. 

Select Edit to edit the setup, Select Delete to remove the setup. 
 
Wireless LAN setting 
Before you can use the wireless networking card to communicate, you need to take a moment 
to set up wireless networking connections. 
The procedure ia as follows: 
 
Note : If you plan to use a wireless configuration, consult your network administrator to verify that the 
wireless networking card is correctly registered. 
 
1. Tap Setup, then tap Network, then tap Wireless LAN. WLAN Setting window opens. 
2. In the Configuration window, tap the Tx Mode dropdown menu. 
3. From the dropdown menu, select the mode you want to use. You can choose one of the 
following modes: 
 
802.11 AdHoc: This mode is used to enable two or more wireless-enabled devices to 
exchange data directly, without an access point. An AdHoc network of which they are the 
only members and over which they can exchange data can be established. To exchange data, 
each device participating in the AdHoc network must also specify the same SSID and AdHoc 
Channel. 
 
Infrastructure: In this mode all data on the wireless network is directed to an access point, 
from which it is routed to the appropriate wireless station. The access point can also be 
configurated so that data can be bridged from the wireless network to wired networks. 
 

1. Enter your SSID(you can get it from your network administrator). The wireless LAN 
interface card scans the available channels. In infrastructure mode it looks for an 
access point; in AdHoc mode it looks for another station that has the same SSID. With 
whatever it finds, it attempts to from a wireless LAN. 

2. Tap on the dropdown menu at the upper right corner of the screen. Open the 
Encryption Window. 

3. From the WEP Mode dropdown menu, select the encryption mode that you want to 
use with the profile. You can choose one of the following modes: 
Disabled: Use no encryption. 
64bit: Encrypt with a 64-bit key. 
128bit: Encrypt with a 128-bit key. 

4. When you enable encryption, you need to specify the key(s) you want, by one of the 
following methods: 

 
Create keys with passphrass: Click the button next to Create Key with Passphrase and type 
a character string in the Passphrase field. As you type, the Wlan Setting uses an algorithm to 
generate four keys used for encryption. This option is specifically applicable for two wireless 
hosts to communicate in peer to peer environment in a secured way. 
 
Create keys manually: If you want, you can create encryption keys manually by clicking the 
button next to Create Key Manually. For 64-bit encryption, you must type exactly 10 
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hexadecimal digits in each of the four key fields; for 128-bit encryption, you type exactly 26 
hexadecimal digits. Then tap OK button to create your encryption keys. 
 

8. 2 Personal setting 
Personal setting is to assign user information, user designated alarm, password, etc. 
In order to set up personal setting of device, tap [Setup] -> [Personal] icon of Main screen. 

   
Alarm setting 

1. For user alarm setup, choose Setup alarm. 

 
2. If alarm setup is chosen, there is blank screen. In order to setup new alarm, choose the 

New Alarm icon of upper tool bar. 

 
3. Input exact data at each blank box. When user input alarm title, user can use 5ea of 

prepared title such as “wake up”, “meeting with”, “lunch time”, “go to”, “deadline”, or 
can input title manually.  

 
4. Set up repeat option and alarm start and finish date. Alarm repeat could be set up in 

order of “Every day”, “Every week”, “Every month”, “Every year” and “None” and 
user can set up to finish alarm after given period or can repeat alarm forever till setting 
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up again. If user finished all data input, click O.K button at the upper of right to save 
setting data. 

5. According to same method, if set up several alarm, alarm list is displayed at alarm 
initial screen. 

6. Alarm Type is for setting of backlight operating when alarm is ringing,  Play Sound is 
the setting of alarm notice by sound. If Play Sound is chosen, user can set up alarm 
sound at popup list of lower. If  Play button of the right of popup list is touched, user 
can listen to the sound chosen beforehand. 

7. When alarm is operated, user can see alarm screen. 
 
 
2-2 Background setup 
You can set the background color and picture for your system 

 
1. Select the pull down menu at the upper right corner, and set the time, date, icon name, 

panel, and background for your device. You can look at the preview of the settings in the 
preview window on the left. 

2. The Panel Transparency lets you control the degree of transparency for the panel. The 
smaller value makes the panel more transparent, and the bigger value makes more opaque. 

3. You can set the background image as you do in your PC by selecting Background Image. 

 
Owner setting 

1. For user owner setup, choose Owner icon. 

 
2. Input exact data. The owner enables you to record any other information that you want 

to associate with your device such as “Name”, Company”, “Address”, “Phone” and 
“E-mail”.  

 
Password setting 

1. User can set up password for the sake of device security. 
2. For the sake of  password setting, user choose Password at Personal setting screen. 
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3. Set up password by four-figure number. After setting of password, device require 

password when device information need to be changed. If user set up Require 
password when device is turned on option of lower, device identify user after 
recognition of password when device turn on.  

 

8. 3 System setting 
In order to set up device system setting, choose System option after click Setup icon at main 
screen. 

   
AppLinker 
AppLinker displays all of files stored in your Exilien. You can select a file to view the file type and 
program used to open the file. You can click on CHANGE button to change the look of the icon for the 
type of the file, or/and can change the program used to open the file. 
 
AppRemover 

Remove function of application which is installed at system memory according to user 
choice. Removable application is limited to application user installed, user can not remove 
arbitrarily the applications pre-installed when device is commenced from factory. 

 
Backup 

Problem for the sake of backup of application data, program setting files and data installed 
in device, in order to save data at Compact flash or other external memory. Also, user can 
recover backup data by this utility. 

Brightness 
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User can control screen brightness and backlight usage. Backlight is related to battery 
consumption, so if user control the lightness, user can lengthen the time of battery usage. Also, 
user can select Turn off the backlight if device isn’t used for and set up backlight to turn off 
automatically if device is not used for a specified period of time.  

 

 
Note 
- In the Brightness Setting, slide the bar to the Dark level to conserve the battery power. 
- The backlight keeps turning off to conserve power. On the Backlight tap, change the 
time the backlight stays on and choose to have the backlight turn on when you touch the 
screen or push a button. 
 

Calibrate 
Touch panel calibration aligns the internal circuitry of your device with its touch-sensitive 
screen so that when you tap an element on the screen, the your device can detect exactly 
which task you want to perform. 
 
You may perform Touch Panel Calibration when the touch panel is out of synchronization. 
It is very important for correct calibration to touch the exact center of the calibration 
symbols every time. Touching wrong place of calibration symbols may cause 
synchronization problem during the touch panel operation. 
 
Perform the following message respectively. 

1. Touch the center of the mark in the upper-right corner. 

  
2. Next touch the center of the mark in the upper-left corner. 

 
3. Next touch the center of the mark in the lower-left corner. 
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4. Next touch the center of the mark in the lower-right corner. 

 
 

5. Finally, touch the center of the mark in the center of display. 

 
Power 

 
Battery remaining time is displayed and user can select 'Turn Off Device If Not Used' in 
Battery Power Management to set up device to turn off automatically if device is not used for 
a specified period of time. User can set up the battery interception time from one minute to 
five minutes according user’s choice. In the case that user use external battery also, user can 
control the battery interception time from one minute to five minutes when device is not used 
for a specified period of time to protect device from damage. 
 
Sync  
lets you choose the connection port for synchronization in either USB or Serial mode. 
 
System 
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Using memory status of device and available remaining memory status are displayed as well 
as system usage status and system version. 
Tap on the icon on the right of the top toolbar and show Memory/Local Storage, External Storage, CPU, 
and Version of OS. Memory/Local Storage shows the amount of the available memory and the memory 
in use. CPU shows the status of the system usage, and the version of the OS. 

 
TaskManager 

 
Operating application contents are displayed and user can control remaining memory 
quantity by optional close or whole close. 
 

Time 

 
Setting of device’s time and date. Because setting time and date chosen are connected 
with Linu@ applications’ time and date, exact time and date setting is very important. 
 

Volume 

 
Setting of device’s sound volume. User can control effect sound, alarm and hardware 
button’s  usage effect sound as well as Multimedia sound. 
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You can select the Screen Taps checkbox to control the effect sound for tapping the screen. 
Selecting the Mute checkbox  turns off the sound, so when your device does not produce sound, 
check if you have selected the Mute checkbox.  
 
 

9 X-Sync 
Your device provides you with applications to manage your schedule, upcoming appointments, contact 
information, tasks and assignments, memos, and e-mail messages. You can run these applications 
independently to each other or synchronize them using X-Sync. For example, you can use X-Sync to 
synchronize and update the information stored in Microsoft Outlook in your PC with the information 
stored in your device. 
 
Note. Installation CD includes two versions of X-sync, for Outlook 2000 and Outlook 2002. 
          Install the correct version of X-sync for your product. 
 
X-Sync lets you synchronize and exchange the information between your device and desktop PC. X-
Sync lets you share the information between the two devices, and automatically updates the data stored 
in one device when you modify the same data in another. The advantage of  using X-Sync is that you 
can create backups that are readily available for data restoration and duplication. 
 

9. 1 Installing X-Sync Desktop software 
You can synchronize information between your device and your desktop computer to 
make sure that both devices have the latest information. You can use X-sync to back up 
and restore data, to install and remove application programs, and to copy files between 
your device and desktop computer. 
 
First,  you’ll need to install X-sync on your desktop computer. 
Follow the following installation procedures to install X-sync, connect your device to 
your desktop computer, and establish a partnership for synchronization. 

 
Caution: For synchronization to work properly, install X-Sync before your Product is 
connected to your computer for the first time. 
 
Installing the USB driver  

1. Connect your device to a USB port on your desktop computer. 
2. If your desktop computer prompts Found New Hardware, follow the instructions to 

install the USB driver. The driver files, EX_USB.INF and EX_USB.SYS, are located 
in the X-Sync disk. 

 
Installing the X-sync Manager  

1. Turn on your computer. 
2. Exit any open programs, including those that run automatically at startup and virus-

scanning programs. 
3. Insert the X-Sync disk into your CD-ROM drive. 
4. If the installation does not begin, click on the Windows Start button 
5. Choose Run. 
6. Type D:/setup, where D is your CD drive and then; click OK. 
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7. Click Next to set up. 

 
8. Select the Destination Folder you want to install the software in, and then click Next. 

 
9. Select the Working group you want to install the software in, and then click Next. 

 
10. Click Finish when you done installation. 

 
Launching X-sync Manager 

1. Click X-sync icon on the main menu. 

 
2. You can see the X-sync manager window. 
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 synchronize button① -starts synchronizing your device and PC. 
 stop button② -stops synchronizing. 
 remote file brower button③ -opens install manager. 
 install manager button④ -opens install manager. 
 synchronize time button⑤ -synchronize the time on your device with the clock on your 

PC. 
 options button⑥ -opens the options window. 

9.2 Function and setting of X-Sync 
X-Sync synchronizes information between your device and your PC through a USB or serial 
cable. PIMS data stored in the Address, schedule, To do, Memo programs can be 
synchronized with Microsoft Outlook application. You  can select which of these PIMS data 
is synchronized. 
X-Sync’s configuration is as follows : 
 

1. In order to connect your device with PC, you need to assign a communication port. Tap 
[Tools] -> [Options] at Memu bar of X-sync or choose the last icon from the upper 
tool bar. 

 
2. After choosing the first item tap (Sync Method), choose your device’s connection 

method . In the case of connection by USB cable, choose Use USB, in the case of 
connection of serial cable, choose Use serial. 

 
- If you chose Use Serial, input serial port number of PC. Generally, it is Com1 

or Com2. If a modem or another device uses a serial port. choose a different 
port for the device. 
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Choose Sync rule tap and select the synchronization rule. 
The three rules of synchronization are as follows. 

      
- Compare modification time : Compare the time that data are saved between 

device and PC data, the latest data replace the old data. Generally, if user 
chooses this mode, user can maintain the latest data anytime because device’s 
data  or PC’s data, only one side’s data are modified 

- Always replace the item on my device : Base on PC’s data, device’s data are 
changed. So, PC’s data overlap device’s data. 

- Always replace the item on this computer : Base on device’s data, PC’s data 
are changed. So, device’s data overlap PC’s data. 

 
3. And then, choose Sync mode tap at upper tap. User can set up the method of 

synchronization between device and PC. The each meaning is as below. 

 
- Only upon connection : Automatically operating on connection of device and 

PC. 
- Manually : After connect of device and PC, user have to tap sync icon to 

synchronize device and PC. 
But, this setting is available in base on USB cable connection. If connection method is Use 
Serial at Sync Method tap, there is displayed that Sync Mode is not available. User have to 
tap Sync icon to operate synchronization manually.  
 
4. Choose File Conversion tap at the far right and select the file conversion type to be used at 
synchronization. If user finish to set up all options, tap OK button. 
 

9. 3 Sync 
1. In order to synchronize device’s data and PC’s Outlook’s data by X-Sync, first of all, 

choose which option is synchronized. 
 

Operate X-Sync to tap X-Sync icon on Basic screen or double click X-Sync manager on 
working tray. Check options which user want to choose at Main screen. All chosen options 
are synchronized with Outlook’s related applications. 
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The items are as below 
 Device   Outlook  
 Address   ------------------- Address Book 
 Schedule ------------------- Schedule 
 Memo     ------------------- Memo 
 Todo    ------------------- Work 
 Mail    ------------------- Incoming box 

 
 

2. If device is connected by USB and Sync Mode is set Only upon connection up, it is 
connected to PC under the device power turn on, synchronization operate 
automatically. If  device is connected by Serial or Sync mode is set Mutually up in 
case of USB, user have to tap X-Sync’s [File] -> [Synchronize] or tap the first icon at 
upper tool bar to start synchronization. 

9.4. Installing and removing applications 
 
Installing add-on applications 
Your device comes with the applications installed and ready to use. You can also install 
additional applications on your device, such as games and other software. 
 
Note : Any game or application that you install on your device resides in memory, you can 
delete them at any time. 
 
Use the Install Manager to install an application on your device from your PC. 
 To install add-on software on your device : 

1. On your computer, copy or download the application you want to install into the any 
directory. 

2. Double click the X-Sync icon( ) on your desktop. 
3. Click install manager. 

 
4. Click install( ). 
5. Select the application that you want to install on your device. 
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Note : You can also access the Install Tool Dialog by selecting Install Tool or by double-

clicking any file with a MIP file extension. 
6. Click open. 

 
Note : Review the application you selected in the Install Tool dialog box. If you do not 
want to install an application, click No. 
7. User can see the install status of applications by bar graph. 

 
8. After installation complete, user can see a message “Application install has been  

succeeded.”. Then Click OK. 

 
9. User can see “Tetris” icon at Install Manager screen and Tetris game is installed in 

Game folder. 

 
Uninstalling applications 
Use Install Manager of X-sync to uninstall application which is installed in device. 

1. Connect device and PC by USB or serial cable. 
2. Operate PC X-Sync. 
3. Click [Tools] -> [Install Manager]  of X-Sync or tap the icon of upper tool bar to 

operate Install Manager. 
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4. User can see applications’ list installed in device at lower screen of Install Manager. 
Example, uninstall Tetris game. 

 
Choose the application user want to uninstall and check in check box. Click [Tool] -> 
[Remove] of Install Manager screen or the second icon of upper tool bar. 
5. User can see a question message whether user will uninstall the application chosen or 

not. Then, chick Yes. 

 
6. After a message which uninstall completed successfully, click OK. 

 
7. User can see that Tetris game is uninstalled at Install Manager screen. 

 
 
Note : Other application uninstall method is [Setup] -> [System] -> AppRemover except to 
use Install Manager. Usage of AppRemover, refer to 0 System setup. 

9.5 Other function of X-Sync 
Remote File Browser 
Remote File Browser is a function to manage files of device by X-Sync. User can copy, move, 
remove files by this function and manage folders. 

1. Connect device with PC by USB or serial cable. 
2. Operate X-Sync of PC. 
3. Tap [Tools] -> [Remote File Browser] of X-Sync or the icon of upper tool bar to 

operate Remote File Browser. 
4. Because Remote File Browser’s function is same as general file manager of PC, the 

usage is same as PC’s. The left screen shows user the current directory structure, the 
right screen shows the directories’ internal file(s) and directory. 
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5. At Remote File Browser , if user use the right button of mouse, user can works more 

easily. If the right button is clicked, user can see as below sub-menu and operate the 
related work. 

 
 

Synchronize Time 
A function to synchronize device’s time and PC’s time, it is for calculation of the exact time 
for data synchronization. 
The synchronization of  time is important since synchronization depends on the modification times of  
data. If a file is modified but the same file stored in another device has the newer modification time, the 
file will not be updated.. 
 

1. Operate X-Sync of PC. 
 
2. If click [Tools] -> [Synchronize Time] of X-Sync or click the icon of upper tool bar, 

user can see a message of device time synchronization. Then click O.K. 

 
3. After Sync Time setup, user can see a message of time synchronization success. Then 

click O.K. Device’s time and PC’s are synchronized. 
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Note :  
Troubleshooting communication problem 
Check your connections: 

a. Check the contact points on your EnDA and on the cradle and make sure they 
are clean and free from obstruction. 

b. Make sure that your EnDA is seated firmly on the cradle. Gently rock it back 
and forth to ensure it is making contact. 

c. Check the cradle connection on the back of your computer to make sure it is 
properly attached. 

d. Perform X-Sync operation.  
 

 
10. Supplementary Information  

10.1 TIPS AND TROUBLESHOOTING 
 
This chapter contains troubleshooting information that can help you to solve any problems 
you might encounter with your device. It also has a tips section that may help you to 
get better service from your device 
 
Resetting. 
If your device responds slowly, stops responding as expected, or “freezes,” try resetting 
it. A reset causes the device to restart and re-adjust memory allocation. 
Unsaved data in open windows may be lost. Use the stylus to press Reset  
 
Note: Do not turn off your device as it must remain on in order to reset. 
Battery Loses Power 
When the battery is low, recharge a low battery as soon as possible. If your device shuts down, 
you still have about a week 24 hours to recharge the battery before you lose the data on your 
device. 
You want your device battery charge to last as long as possible, especially when 
you’re on the road. Under normal conditions, you can get many hours of use from a full 
charge.  
The following tips to help you get the most from them: 
 
Use external power whenever possible 
Use the AC adapter to plug your device into external power whenever possible, 
especially when: 
• Using a CompactFlash card. 
• Connecting to a computer. 
• Playing audio files for extended periods. 
 
Shorten auto-suspend time 
While on battery power, your device automatically suspends operation if you 
haven’t touched the hardware buttons or used the stylus for a certain period of time. 
Maximize battery life by shortening the Backlight Shut off time. Tap setup, then tap system, 
then tap power, and adjust the On battery power Management Setting and the External 
Power Management Setting. 
 
Turn off sounds you don’t need 
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The device produces sounds in response to a number of events, such as warnings, 
appointments, and screen taps or hardware-button presses. To optimize battery life, turn 
off any sounds you don’t need. Tap Setup, then tap System,  then tap Volume, and uncheck 
the Enable Sound Effects For. 
On the Personal tab, tap Sounds & 
Reminders and clear check boxes on the Volume and Reminders tabs. 
 
Turn off Backlight 
Tap Setup, then tap System, then tap Brightness. Under the System Light Setting, check the 
Turn Off. 
 
If You Forget Your Password 
If you forget your password, contact your local customer service center. 
If You Run Out of EnDA Memory 
Memory on your device is shared between storage memory and program memory. 
Storage memory is used to store the information you create and programs you install. 
Program 
memory is used to run programs on your device. The device automatically 
manages the allocation between storage and program memory. However, in some 
situations, such as when memory is low, the device may not be able to automatically 
adjust the allocation. If you receive a message stating that storage or program memory is 
unavailable, try the following solutions: 
 
• Move data to a storage card. 
• Delete unnecessary files. 
• Remove programs you no longer use. Tap setup, then System,  then AppRemover. Select the 
programs you no longer use, and tap the Trashcan icon to remove them 
 
Screen Freezes or Responds Slowly 
Reset your device. See “Resetting”, earlier in this chapter. If the symptom continues, you may 
have run out of memory. Check your memory usage and clear storage memory as described 
above. 
 
Screen is Blank 
If the device doesn’t respond when you briefly press the Power button, press and 
hold the button for a full second. If that doesn’t work, try the following in order until the 
problem is resolved: 
• Plug the device into AC power. 
• Reset the device. See “Reset the device”, earlier in this chapter. 
 
Screen is Dark 
Prolonged exposure to direct sunlight may cause your device screen to temporarily 
darken. This is normal for LCD screens and is not permanent. 
 
Screen is Hard to Read 
• Adjust the backlight brightness level. Tap Setup, then tap Brightness. Move the slide bar 
under System Light to adjust the backlight brightness level. 
• Position a lamp so that the light shines directly on the screen. 
 
Inaccurate Response to Stylus Taps 
Adjust the touch screen to respond more accurately to screen taps. Tap , then Setup. 
On the System tab, tap Calibrate. 
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Infrared (IR) Connection Problems 
If you are unable to use IR to transfer information, try the following: 
• Transfer only one file or no more than 25 contact cards at a time. 
• Line up the IR ports so that they are unobstructed and within a range of 12 inches 
(30centimeters). 
• Make sure nothing is between the two IR ports. 
• Adjust the room lighting. Some types of light interfere with IR connections. Try moving 
to a different location or turning off some lights. 
 
Network Connection Problems 
• The following solutions may help if you encounter with network connections.  
• Verify that you have an Ethernet card that is compatible with your device. 
• Verify that you have added necessary server information 
• If Network Connection isn't listed as a connection method in the X-Sync dialog 
box when starting synchronization, wait a few minutes and try again. Also, if synchronization 
does not start right away, the network is probably busy, and it may take a minute for your 
device  to connect to the network. 
• Make sure that the proper drivers for your card are installed on the device. For 
more information, see the owner’s manual for the network card. 
• Verify with your network administrator that your user name and password are correct. 
• Verify with your network administrator that the network you are trying to connect to is 
available, or try to connect to it from another computer. 
 
Cable Connection Problems 
The following solutions may help if you encounter problems when connecting to your 
computer.  
• Ensure the device is turned on. 
• If a modem or Ethernet card is inserted into your device, remove it. 
• Ensure that you do not have any other active connections.  
• Ensure the cradle’s cable is securely plugged into the appropriate port on the back of your 
computer. Use the cable that came with the device cradle without any extra 
cables or extenders attached. 
• Ensure your device is securely placed into the cradle. 
 
Battery Guidelines 
Because of the type of battery used in your device, follow local regulations regarding 
the safe disposal of your device. Your product vendor can advise you on local 
regulations, and/or the existence of any battery disposal programs in operation. 
The device should not be disposed of along with the general household waste. In 
order to forward them to recycling or dispose of them properly, please use the public 
collection system 
To reduce the risk of electric shock or damage to the internal components, do not 
spray liquid directly on the screen or allow excess liquid to drip inside your device. 
Using soap or other cleaning products on the screen may discolor the finish and 
damage the screen. 
 
Travel Guidelines 
For safety and convenience when traveling with your device, follow these guidelines: 
• Back up your data before you leave. 
• Take a backup copy of your data with you. 
• Disconnect all external equipment from your device. 
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• Take the AC adapter and new batteries with you. 
• Hand-carry your device in the protective case. Do not check it with your luggage. 
• Be aware of potential effects of airport security devices on your device. 
• Check with the airline if you plan to use your device on the plane. In-flight use of electronic 
devices is at the discretion of the airline. 
 
International Travel 
Before traveling internationally with your device, be sure to: 
• Check local customs regulations. 
• If using an external modem or CompactFlash/PCMCIA card modem, be sure to have the 
correct modem and cable for the country you are visiting. Telephone lines differ from country 
to country. 
 
Shipping Guidelines 
When shipping your device, follow these guidelines: 
• Safeguard your data by making a backup copy. 
• If shipping the backup copy, be sure that the CompactFlash card is not exposed to electrical 
or magnetic impulses while stored or in transit. 
• Turn off your device and disconnect all external devices. 
• Pack your device and all external devices (such as the cradle, cords, and cables) in their 
original packing boxes or in similar packaging with sufficient packing material to protect 
them. 
There are three types of airport security devices: X-ray machines, magnetic detec- 
tors (the device you walk through), and security magnetic wands. You can send 
your device through airport X-ray machines. However, HNT recommends that 
you do not send your device through magnetic detectors or expose it to security 
magnetic wands. 
 

10.1 HARDWARE SPECIFICATIONS 
 
System Specifications 
Operating System   Embedded Linux 
Processor   Intel StrongARM 206MHz SA-1110 32bit RISC 
Memory   Default : 16-MB flash ROM, 16-MB SDRAM  
                 Option : 32-MB flash ROM, 32-MB SDRAM 
Display   3.8inch TFT LCD Reflective type, CCFL frontlit, 240 x 320 pixels, 65,536 colors,  
               TouchPanel 
Backlight   5-level brightness 

Manual adjustment of brightness level 
Audio   Internal speaker, Stereo phone 
Interface   IrDA, data transfer up to 115.2kb per second 
                  USB 
                  RS232C - Option 
Communications   Communication port, Expansion Pack connector 
Indicator(LED)   Power status, Voice recording status 
Battery   Internal type, Li-ion rechargeable 1,050mAh 
Expansion slot   Compact Flash Type 1/2 
Others   DC jack (EIAJ RC-5320A standard(Voltage Classification 2) 
               Phone jack (DIA 3.5 Miniature Stereo) 
 
Physical Specifications 
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Height   5.19 in, 132 mm  
Width   3.23 in, 82 mm  
Depth   64 in, 16.4 mm  
Weight   5.92 oz, 168 g  
Temperature   Operating 32° to 104°F 0° to 40°C 

Nonoperating -4° to 140°F -20° to 60°C 
Relative humidity(non-condensing)   Operating 20 to 90% 20 to 90%  

(Nonoperating 20 to 90% 20 to 90%) 
Maximum altitude(un-pressurized)   Operating 15,000 ft. 4,572 m 

 (Nonoperating 40,000 ft. 12,192 m) 
 

 


